
How to use this handout.

This handout is not a comprehensive reference guide to After Effects. For a refer-
ence guide either use the online help, under the After Effects ‘Help’ menu, or consult
the After Effects 4 user guide (available from Andy)

This handout is not a step by step tutorial. Step by step After Effects tutorials can be
found in Adobe’s Classroom in a Book. Copies of the exercises in this book can be
obtained from Andy and the tutorial files needed to complete the exercises should be
installed on the level 2 / 3 TVFD Macs.

What this Handout is, is an overview (detailed in places) of the basic ideas, princi-
ples and techniques which make After Effects work. It is, if you like, the bigger pic-
ture. It is best used as a compliment to the Classroom in a Book tutorials as it will
give you a summary of some important points it is easy to overlook if you are follow-
ing a tutorial.

What is After Effects / What does it do ?

After Effects is often called a ‘Photoshop’ for moving images.For example:

•Just as Photoshop can apply filters to still images, After Effects can apply filters to 
moving images: animated images and video.

•Just  as Photoshop allows you to build-up complex images in layers, so does After 
Effects

•Just as Photoshop allows you to select and make certain parts of an image trans 
parent, so does After Effects. 

Because it deals with moving images, AfterEffects also has much in common with
video editing packages such as Premiere: It allows you, like Premiere, 

•To ‘build-up’ different channels of video in layers. 

•To make channels fade in and out

•To work with sound and images

•To ‘key’ out certain colours and areas

•To have layers of video move around the screen as they play

After Effects can be used to create animations or to mix ‘straight’ video with anima-
tion and or text.

But After Effects does all of this and more with a greater sophistication than the
other packages available to us.
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What can we import into After Effects?

• Photoshop files (including individual layers from a multi-layer file)
• Premiere movies (in fact any Quicktime movie)
• Premiere Projects, before they have been converted into movies
• Adobe Illustrator files. Very important this as it allows us to use “small”, “portable”  
Vector graphics for text and animation 

• Audio files

A quick tour of After Effects Windows & their main functions.

The Project Window

You can import audio files, Quicktime Movies, Photoshop files (and individual layers
from photoshop files), Adobe Illustrator files and Premiere Projects into After Effects.
Once imported into a new After Effects Project, all of these items are stored in the
Project window.

Clicking once on any item in the project window,
allows you to see a ‘preview’ of that itemwith
details about it.

Compositions

We use a composition to assemble the items we
have imported into the project window. When we
first create a composition we have the option to
select such properties as screen / Frame size,
frame rate and the length of the composition.
These settings are important as they affect the
appearance of your final After Effects movie.

Composition Settings are much like Premiere
project settings.

The Time Layout Window

Individual items fromthe project window are assembled in a ‘Composition’. Most of
the composition will be put together in the ‘Time Layout Window’.

Items from the Project Window appear in the Time Layout window as layers. The
Time Layout Window is similar to the Premiere ‘Construction Window’ and shows 
different layers of audio and video, and how they change over time.

The Composition Window

The Composition Window allows you to see the
effects of the decisions you make in the Time
Layout Window. The Composition Window allows
you to see all of the layers in your composition
as they will appear on screen in your finished
‘movie’

The Tools Palette

The ‘Tools Palette’ gives you access to a number of well . . . tools,
which can be used in particular to create masks and paths, very impor-
tant to your use of After Effects.



Layer Windows

Clicking on any layer in either the Project Window
or the Time Layout Window, opens a layer window
for that layer.

The layer window can be used for example to apply
masks and paths to a given layer.

The Render Queue

When you’ve finished working on
your Composition, you need to
‘render’ your work into a
‘Quicktime Movie’, a self conatined
A/V file that can be played without
the need to have After Effects
installed on your machine. 

The Render Queue allows you to
make important decisions about
the size and quality of your fin-
ished movie.

So how does After Effects Work: Layer Properties & Keyframes

The key to using After Effects is to master the idea that a clip / movie etc placed
into After Effects has certain ‘properties’ such as its size, its opacity and its angle of
rotation on the screen. These properties can be changed over time, so the appear-
ance of a clip itself can be changed over time in a variety of ways. 

At the head of the column opposite, we can see a layer in the time layout 
window (in this case a movie clip called ‘house’), which has been ‘expanded’ to
reveal a number of different properties including, position, scale, rotation, and opaci-
ty.

So how do we change the
appearance / properties of
a movie / clip over time?

To look at changing the
value for a property - lets
take opacity as an example. 

First we have to identify where we want any change in opacity to begin.Having
done this we place the current time marker at that spot (it can be dragged to the
spot required).

Having dragged the current time marker to the
point in time where we want a change in value
to begin we need to click on and activate the
“stop watch” icon next to the property (in this
case opacity) that we want to change. 

This will create a small ‘diamond’ shape at the current time marker. This ‘diamond’
is called a ‘Keyframe’ and it shows that a particular value has been set for a layer
property (in this case opacity) at this particular point.

The next step is to change the value of the property
(opacity) at the point in time we have selected (the
position of the keyframe). To do this we click on the
underlined (opacity) value to the right of the property
name. This opens in this case the Opacity window,
where we can type in a new value for opacity. When
happy click on OK.

The Current time marker

A layer ‘expanded’in the
Time layout window to
reveal different properties.



We have now created our first Keyframe and assigned it a value. So we have start-
ed the process of changing a layer’s opacity over time. But to continue the process
we need to add further keyframes to tell the opacity how to change over time. 

First we have to drag the current
time marker along the timeline to a
new point further along. As we can
see in the example to the left. 

Now we simply click once again on
the underlined opacity value to open
the ‘opacity’ window and change the
property for opacity at this new point
in time.

Doing this automatically creates a new keyframe (new diamond) at the point where
we have left our current time marker.

By creating two keyframes at different points in time and assigning different values
to a property (in this case opacity) at each keyframe, we allow AfterEffects to fill in
all the values for that chosen property between each keyframe.

In this example we have changed Opacity from ‘0’ at the first keyframe to ‘100’ at the
second keyframe. So opacity for this layer increases from 0% at the first keyframe to
100% at the second keyframe. At any point in the timeline between these two
keyframes the value for opacity will be somewhere bewteen 0 and 100. We can
check this by placing the current time marker between the first and second
keyframes and then checking the opacity value, as shown in the diagram below

Changing position: “Spatial interpolation”

Up to now we’ve looked at how we can manipulate the properties of a layer, in par-
ticular things like opacity and rotation. We can also adjust the position of a layer
over time using much the same processes as we use to change rotation etc.

To change the position of a layer over time we
work in the composition window (pictured left) to
change position of the layer on screen and in
the time- layout window (pictured below) to
determine how that change in position takes
place over time: we change the position of the
layer itself in the Composition window by drag-
ging it with the mouse, while moving the current
time marker along the time line in the Time
Layout window, creating new  keyframes for
position as we go at different points in time.

The keyframes we create are displayed in both the Composition and Time Layout
windows and correspond to one another. The process goes like this.

1. With the object on view in the time-Layout and Composition windows, and posi-
tioned in the Composition window in its correct starting position, expand the layer in
the Time Layout window until you can see “Position” listed under the
Transformation”properties. Make sure that your current time marker is set to the
point in time where you want your layer’s movement to begin, then click the Position
stopwatch to create a first keyframe for position.

over >>>
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Keyframe 2
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Keyframe 3
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Having created the first Position keyframe, we
now move the current time marker, in the time
layout window to the point in time at which we
want to create the next keyframe. Having done
this, we move back to the Composition window
and, clicking on our layer, drag it to the point in
the Composition window we want it occupy by
the time our movie reaches the second
keyframe (see diagram left).

To move the object / layer again, we simply
repeat this process: first, move the current time

marker on to a new point in time, then drag the layer in the composition window to a
new position, this creates a third, new Position keyframe. When the movie is played,
the layer will now move along the path we have created in the composition window.
This path is called a motion path.

Linear and Bezier spatial interpolation 

Up to now the paths shown here, that we have created for our layer to move along
have been straight paths, the layer’s movement has been “Linear”, but we can also
make our layer move along curved paths in the composition window. This motion
along a curve is called “Bezier” motion because of the type of curve used. We
change motion paths from Linear to Bezier at any point simply by clicking on the
keyframes which define the path either in the Time Layout or Composition windows
and then selecting Keyframe Interpolation from the Layer menu at the top of the
screen. Selecting Keyframe Interpolation in this way opens the Keyframe
Interpolation window . . .

The Keyframe Interpolation
window allows us to toggle
between Linear and Bezier
motion paths (so long as we
have relevant Position
keyframes along the motion
path selected first). 

Selecting Bezier as opposed
to Linear Spatial interpola-
tion, with one or more
keyframes along a motion
path selected, will allow us to
change the path from a
straight line to a curve. 

The shape of this curve can
then be altered by clicking
and dragging on the ‘han-
dles’ which now appear
beside each keyframe along
the path, in the Composition 
window.

Linear and Bezier Temporal Interpolation

It’s not only motion paths that make use of Bezier curves in After Effects. Bezier
curves can also be used to change the rate at which events take place and proper-
ties change. Lets look at the example of changing opacity for a layer. In the exam-
ple below opacity changes from 100% to 0% between two keyframes.

Keyframe 3

Keyframe 2

Keyframe 1

Keyframe 3

Instead of dragging a layer in the compo-
sition window to reposition it, an exact
position in the composition window can
also be set for any point in time, by click-
ing here and typing in a series of ‘x’ (hori-
zontal) and ‘y’ (vertical) coordinates.

Clicking and dragging the ‘handles’
next to each keyframe along a
Bezier motion path changes the
shape of the curve which comprises
that path

Keyframe 2

Keyframe 1

Keyframe 3



If we now Expand this layer’s Opacity properties, which we do by clicking on the
right facing arrow right next to the Opacity stopwatch, we can see a visual represen-
tation of the change in opacity that is taking place.

This straight diagonal line between keyframe 1 and keyframe 2 tells us that the
change in opacity we have created takes place at a constant rate, neither getting
faster or slower as it progresses. This kind of constant change over time is known
as Linear change or - wait for it - Linear Temporal Interpolation.Temporal
Interpolation means, basically, change over time.

In the same way we can change spatial interpolation from Linear to Bezier (straight
lines to curves) so we can change temporal interpolation from linear to Bezier, which
means we can make change over time accelerate or decelerate.

We can change Linear Temporal Interpolation to Bezier Temporal interpolation by
first highlighting any relevant keyframes, by clicking, and then selecting Keyframe
interpolation from the Layer menu. This opens up the Keyframe Interpolation win-
dow, and allows us to toggle between Linear and Bezier interpolation (as shown
below).

If we change Temporal interpolation for our changing Opacity from Linear to Bezier
we can affect the rate at which change takes place. To do this we need to return to
the Time Layout window.

In the Time Layout window two things have happened. Firstly the shape of the
keyframes has changed to show us that we have selected Bezier as oppposed to
Linear interpolation and Secondly Bezier handles have appeared at each end of our
straight opacity-change line. By dragging on these handles it is now possible to
change that straight line into a curve, Changing the straight line to a curve means
that the opacity no longer changes at a constant rate.

The curve above shows that Opacity now changes not at a constant rate but at a
variable rate, first accelerating where the curve is steeper and then decelerating
where the curve is shallower. This relationship is worth remembering:

curve getting shallower = decelerating change.
curve getting steeper = accelerating change.

Applying Effects to a Layer

A range of effects and filters can also be
applied to layers in After Effects. Many of
these filters and effects will be familiar to
you from your work with Photoshop.
Numerous filters and effects can be
applied to any given layer. These effects
are accessed by selecting them from the
Effects menu at the top of the screen:

Bezier Handles



It is important to ensure that the layer you want to apply an effect to, is selected in
the Time Layout window before you select an effect from the Effects menu, as
selecting the effect applies it to any selected / highlighted layers. 

When you select an effect to
apply to a layer. The layer’s
Effects Control window opens
allowing you to dictate specific
details about how an effect is
applied to a layer. In the exam-
ple shown here, you can see
that we can alter the amount of
blur applied to a layer, by drag-
ging the adjustment slider
(shown left) using the mouse.

Changing an Effect’s Properties Over Time

This type of adjustment to an effect adjusts its application to the whole of a layer, at
all points in time. However just as layer properties like rotation, opacity and position
can be adjusted over time so an effect’s properties can also be adjusted between
different points in time. For example for the effect shown above (Gaussian Blur) the
“blurriness” of the effect - and so the blurriness of the layer it is applied to - can also
be adjutsed over time.

We adjust an effect’s properties over time in just the same way we adjust layer
properties like ‘opacity’: by moving through the timeline, adding keyframes and
changing the value for properties at each keyframe, allowing After Effects to fill in all
the values between keyframes.

In the example above, it is the blurriness of the Gaussian Blur filter that is being
adjusted over time, using keyframes. When an effect is applied to a layer, the con-
trols which open in the Layer Effects window also appear under that layer’s Effects
controls in the Time Layout Window.

So not only can we alter the appearance of a clip over time, by changing eg. its
rotation etc., we can also alter the appearance of any effect or filter applied to that
clip.


